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Using TimePro  
 
The first section of this manual deals with the day-to-day use of TimePro. If you want to know 
about setting up and configuring TimePro, see the section of this manual entitled ‘Configuration of 
TimePro ‘ on page 30. 
 

What is TimePro? 
 
The TimePro system consists of an electronic clock terminal and software that processes and 
analyses employees’ clockings made at the terminal. Employees use the terminal to clock in and 
out of work and can also clock on and off jobs. When used for clocking on and off jobs, the 
TimePro system also records what type of work has been done. This is achieved by entering a two 
digit ‘Sale Code’ when the employee clocks onto a job. If an employee who clocks on jobs does not 
have a job, the system will record this non-productive time by using ‘special’ job numbers. The 
TimePro system will also record if an employee does not clock onto a job or a non-productive 
activity. 
 
The clocking data is stored in the terminal until it is downloaded into the computer that is running 
the TimePro software. The data can then be checked for incorrect clockings and various reports 
produced. These reports include attendance, payroll information, holidays, absence, job efficiency, 
profitability and lost or non-productive time.  
 
TimePro has also been designed to integrate with your Dealer Management System (DMS). The 
DMS system produces details of hours sold for each job. TimePro then uses these figures to 
calculate the time allowed for each person who has worked on that job. 
 
Using TimePro divides into these areas 
 

1. Communicating with the clocks(s) 
2. Booking Holidays and Absence 
3. Checking / editing the Time and Attendance Data 
4. Checking / editing the Job Costing Data 
5. Printing the required reports 

 

Communicating with the clocks(s) 
Click the clock button on the top toolbar to open the clock screen.   
 
This screen defaults to ‘Normal Collection’ and ‘All Hard wired Clocks’ (See ‘Clock Operations’ on 
page 25 for details of other clock operations) 
 
Click the  ‘Run Clock Operation’ on the lower toolbar, you will be asked to confirm the operation, 
Click Yes, TimePro will then start downloading the data from the time clock(s), wait until this 
operation has finished and the progress bar has closed.  If TimePro does not communicate with 
the clocks(s) you will receive a time-out message after about 10 to 15 seconds. This is probably 
because of the clock was in use at the time you tried to do the download, in which case just repeat 
the operation.  
If you have clocks on remote sites that are connected by modem, select the appropriate clock from 
the dropdown box at the top of the clock screen and repeat the download operation. 
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After each download, TimePro will process the clockings. The status of the process is shown to 
you via a progress bar. 
 
When all clocks have been downloaded, close the clock screen by clicking the ‘Stop’ button on the 
left of the lower toolbar. 

Booking Holidays and Absence 
Holidays and absence can be booked into the programme at any time. 
 
Click the ‘Holiday / Absence’ button on the top toolbar.   
 
This screen has three ‘tabs’ 

Book 
This is where you book any absences; use the dropdown boxes to filter the companies, 
groups and employees you wish to book absence for. To book individual employees, 
uncheck the ‘All employees’ box and click the check box next to the employee(s) that you 
are dealing with. 
 
Choose the type of absence form the ‘Type of Absence’ dropdown box. The ‘Paid’ and 
‘Rate’ values will default to the values that you have set up for this absence. You can 
override these if you wish. If the ‘Paid’ box is checked the employee will be paid at the rate 
shown in the ‘Rate’ field. 
 
In the Hours section you have the following options: 
• Use Day Rules, this will use the number of hours allocated in the Day Rule. 

 
• Use Overtime Rules, this will use the number of hours allocated in the Day Rule but will 

use the overtime rules for payment. For example, if the Day Rules absence hours are 
eight with the first seven hours paid at rate 2 and the remaining hours paid at rate 2 and 
you check the ‘Use Overtime Rules’, seven hours will be paid at rate 1 and one hour at 
rate 2. You can use this facility to pay two different rates of pay for absence even if the 
employee normally is paid overtime on a weekly basis. 

 
• Specify, use this option to pay a specified time in hours and minutes. The first time will 

be paid at the rate shown in the ‘Rate’ box at the top of the screen, the second time will 
be paid at the rate specified in the ‘Rate’ box to the right of the second time field. 

 
Check the ‘Reduce Holidays’ box if you want the absence to be deducted from the 
employees’ holiday entitlement. Check the ‘Half Day’ box to reduce the holidays by half a 
day.  
 
Check the 'Do NOT include in Overtime calculations' box if you do not want the paid 
absence to count towards any overtime, for example, an employee must work 40 hours 
before he moves to an overtime rate. If you wish the paid absence to be included in the 40 
hours, leave the box UNCHECKED, however, if you wish the employee to work 40 hours in 
addition to the paid absence then CHECK this box. (The same principle applies to 
employees on Daily Overtime) 
 
Choose the date range that you are booking the absence for by using the ‘From’ and ‘To’ 
date boxes (clicking the arrow at the side of the box will show a dropdown calendar) 
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Finally, if the date range includes weekends and you wish to book those days check the 
‘Include Weekends’ box. 
 
To confirm the absences, click the ‘Book’ button on the lower toolbar. 
 
If try to book more than one absence for the same employee on the same day, you will be 
given a warning with an option to book the additional absence or cancel. If more than one 
absence is booked, the ‘Multi Absence’ field will be set to ‘Y’ (see Edit Tab) 
 

Edit 
 
Once absences have been booked, they can be viewed and edited here.  
The default view is all absences after the current date, to see earlier dates, click on the 
dropdown calendar and choose the required date. Alternatively, check the ‘Show All 
Absences’ box to see all records. 
The records can be sorted in date or employee order by clicking on the date or employee 
column header, clicking the header again will sort in descending order. 
 
You can change the time paid, the rate of pay, and whether holiday entitlement is reduced 
or not. Just type in the new values, to change the reason for the absence click on the row 
you wish to change in the ‘Reason’ column. A dropdown box will appear from which you 
can choose a new reason. 
 
To delete a booked absence, click in the row you wish to delete and click the ‘Delete’ 
button on the lower toolbar. To delete multiple records, hold the Control (Ctrl) key down and 
click on each record on the box at the left hand end of the row, each row will be highlighted 
as you select it. Click the ‘Delete’ button. 
 
The ‘Multi Absence’ column indicates if you have booked more than one type of absence 
for an employee on the same day. (The last absence booked will be shown in the reason 
column)  
 

Absence Codes 
 

To ‘Add’ a new type of absence, click the ‘New’ absence button on the lower toolbar and 
type in a description. If you wish to pay an employee for this absence, change the paid 
column to a ‘Y’, in the rate column, enter the rate at which it will be paid. 
 
To ‘Delete’ an absence, click on the row you wish to delete and click the ‘Delete’ button on 
the lower toolbar. TimePro will not allow you to delete an absence if it is already in use. 

Making Ad-hoc Payments 
 

You can use the Holidays and Absence screen to make ad-hoc payments that are not 
catered for by normal clocking etc. For example, you wish to pay employees an extra 
payment equivalent to one hours work at rate 2 if they work at night. 
 

• Create a new absence code called ‘Night Shift Premium’ 
• Set the rate as 2 
• When an employee works at night, simply book an ‘absence’ of Night Shift Premium 

and use the specify option, enter 1 hour as the time to pay. 
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Checking / Editing the Time and Attendance Data 
As the data is downloaded into TimePro, the clockings are processed against employees shift 
patterns etc. if every employee clocks in and out correctly, no further action will be required. 
However, in the real world, people forget to clock in or out (or even both!) so it is necessary to 
check that no errors exist. 
 
Click the ‘Time and Attendance’ button on the top toolbar.    
 
The Time and Attendance’ screen is empty when first shown, click the ‘Refresh’ button on the 
lower toolbar to bring the latest data onto the screen. If you wish to see data for previous weeks, 
click the ‘Week Ending’ dropdown box at the top of the screen and choose the desired week. 
 
At the top of the screen are dropdown boxes that will allow you to filter the employees by company 
and groups. You can also see records for only current employees (the default) or all employees 
including those that are on hold (see ‘Employee Tab’ on page 21) 

Screen Layout 
The top half of the screen shows the attendance clockings for the first employee. 
There are four ‘Tabs’ that give different views: 
 

1. Edit 
This is the only view where the clockings can be edited, deleted of added. Also on this 
screen is a column entitled ‘Status’, this shows if any errors such as uneven clockings have 
been found. 
 

2. Rounded 
This shows how the actual clockings have been rounded in accordance with the Day Rules. 
 

3. Actual 
These are the actual clockings as entered at the clock. 
 

4. Combined 
This view shows both the edited and rounded values for each clocking. 

 
The lower half of the screen shows the calculated hours to be paid at the various rates of overtime 
for each day. Also shown is the gross pay for each day as well as total hours and gross pay. There 
are two further columns on the lower grid: 
 

1. Brought Forward (B/Fwd) 
If weekly overtime is in use, any time that is carried over for work done after the week 
‘ends’ time will be shown here. 
 

2. Cash Adjust (£/Adj) 
If you wish to make a one off cash payment to an employee you can enter the amount here. 
To note the reason for the cash adjustment, click the appropriate button (for the day you 
are dealing with) to the right of the lower grid. This will display an input box. 

 

Editing Data 
To edit a clocking, ensure that the ‘Edit’ tab is clicked, click on the clocking you wish to edit and 
type in the new value. Press enter to save the new value. If you press the escape key whilst editing 
the clocking, the original value will be restored. 
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To add a new clocking, click on an empty cell anywhere in the row and type in the new clocking 
value. Press enter to save the clocking. Do not worry if the clockings are not in order, TimePro will 
sort them when it calculates. 
 
To delete a clocking, click on the cell you wish to delete and use the backspace key or spacebar to 
erase the clocking, 
 
You can add and delete clockings from any point in the rows, you do not have to shuffle clockings 
to put them in the correct order; TimePro will do this for you when it calculates. 
 
NOTE: Midnight Clockings. Midnight (00:00) is the first minute of the day. If an employee has 
forgotten to clock off on a shift that ends at midnight, the clocking should be inserted on the day 
after that shift was started. 

Overriding the Overtime Calculations 
In most cases, the hours to be paid at rate 1,2 etc can be determined by the Day Rule / Shift setup. 
If you have a situation that can not be catered for in this way, you can override the amounts to be 
paid by amending them in the lower grid. The total amount of hours to be paid must equal the time 
worked. After amending the rates, click the appropriate ‘lock’ box on the RH side. TimePro will not 
let you lock a record is not correct. 
 
If you amend a clocking or book an absence after locking a record, it will be unlocked when 
recalculated. 
 
When you have finished editing, click the ‘Calculate’ button on the lower toolbar. 

Other Toolbar Buttons 
 
Use the First, Previous, Next and Last buttons on the lower toolbar to move from employee to 
employee. 
 
Use the Previous Week and Next Week buttons to move from week to week. (From build 3.0.203, 
holding the shift key down as you move from week to week will stay with the same employee) 
 
The ‘Refresh’ Button shows the latest values, including changes made by other users on a 
network system. 
 
The ‘Calculate’ button will calculate the data to reflect any changes that are required if you have 
edited any data. You can see if this is required by looking at the status bar of the main screen, 
which will show the words ‘Calculate Required’. There is also a ‘Calculate’ button on the top toolbar 
that carries out the same function. TimePro will automatically calculate if it is required when you 
move to another week or close the Time and Attendance screen. 
 
Clicking the ‘Next Discrepancy’ button will take you to the first record that TimePro can find with 
an error. Click this button again to move to the next discrepancy and so on. 
 
The ‘Add New Records’ is used to create blank daily records. Normally TimePro creates a record 
for each employee for the appropriate dates as data is received form the clocks. Should a clock be 
out of action it is possible to create new records so that you can enter clockings manually. Select 
the date range required form the dialog box and click ‘OK’ 
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‘Recalculate’ as TimePro processes the clockings; the current values for rates of pay, Day Rules, 
job sale and cost values etc are applied. If you change any of these values and wish to apply them 
retrospectively, you will need to recalculate. Select the employees affected and the date ranges 
required and click ‘OK’ 
 
‘Book Absence’ if you are in the Edit Tab, click on the row in the Status column for the record you 
are working with. Click the ‘Book Absence’ button, the Holiday and Leave screen will be shown 
with employee and date you are working with. Choose the required absence and click ‘Book’. 
When you return to the Time and Attendance screen it will refresh to show the booked absence. 
 
NOTE: Right clicking the mouse can access many of the above toolbar functions. 

Checking / Editing the Job Costing Data 
 
Before editing any of the job costing data you should ensure that you have checked and corrected 
the Time and Attendance clockings first as job clockings will not be processed until the relevant 
Time and Attendance data is correct. 
 
Click the ‘Job Clockings’ button on the top toolbar.   
 

Screen Layout 
At the top left of the screen are dropdown boxes that allow you to filter jobs to companies and 
employees. In most cases you would leave these set to ‘All’. 
 
The next two dropdown boxes allows you to filter the job clockings that you will work with. The 
default is a single Job Number, with the job status as ‘All’. Other options are ‘All Jobs’ and ‘By 
Date’ when you choose the later, the date field boxes are enabled and you can select the ‘From’ 
and ‘To’ dates. (NOTE: the records are not filtered until the ‘To’ date is set). 
 
Using the ‘Productive Status’ dropdown you can filter jobs further. This gives the following options: 
 

1. All 
Shows all Job Clockings. 
 

2. Productive 
Shows only Job clockings that are for actual Jobs. 
 

3. Non-Productive 
Shows Job clockings on Non-Productive jobs, these have the special numbers from 2000 to 
2050. 
 

4. Missed 
Shows Job clockings that have been created by TimePro because the employee did not 
clock onto a job within the specified period from his start time. These clockings have the 
special number of 1997. (See ‘Default Job’ in the ‘Employees’ Section on page 21) Any 
‘Missed’ clockings should be changed to an appropriate Job or Non-Productive number. 

 
Below this section is a record grid. Each row of the grid shows a Job Clocking. The full detail of the 
clocking is shown in the lower half of the screen, therefore as you move from row to row, the boxes 
in the lower half will show the detail for the current record. 
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Editing Data 
To see clockings for a single job, select ‘Job Number’ from the ‘Job’ dropdown and select ‘All’ from 
the ‘Productive Status’ dropdown. Type the Job Number in the Job Number box and press the 
enter key. 
The grid will show all clockings for that Job Number. You can edit any of the values that are blue in 
the edit boxes, which are: 
 

1. Job Number 
This can be changed to a valid Job Number or a Non-Productive number. Clicking the   
button next to the Job Number box will give you a list of non-productive codes. 
If you change from a Non-Productive code to a Job Number, the sale code will be changed 
to 5 and the sold / allowed time set to zero. If you change from a Non-Productive code to a 
Job Number you will be prompted to change the sale code and the time allowed will be 
changed to time taken. 
 

2. Clock On Time 
It is only possible to adjust the ON time of a job, this is because TimePro will automatically 
adjust the OFF time for you. If you alter the ON time of a job the previous job OFF time will 
be adjusted accordingly (when TimePro calculates).  
 

3. Sold or allowed time. You can change the sold time for an individual clocking but TimePro 
will do this for you automatically when it calculates against the time received from the DMS 
system. You can override the allowed time on a technician by technician basis (See the 
paragraph entitled ‘Inputting Sold / Allowed Hours’ later in this section) 
 

4. Sale Code 
This can be set to a valid Sale Code, click the  button to get a list of available codes. 
You cannot set a non-productive clocking to anything other than 5. 
 

 

Inserting a Job Clocking 
If an employee forgets to clock onto a job or non-productive activity, this can be done via the 
TimePro software. Click the ‘Insert Clocking’ button on the lower toolbar. Fill in the appropriate 
fields. You only need to know the start time; TimePro will work out the finish time and adjust the 
other clockings accordingly. 

Deleting a Job Clocking 
It is not possible to delete a job clocking. The clocking should be corrected to the appropriate job 
number or sale type. Alternatively, you can set the clock ON time to the same as the OFF time.  

Overriding Sold / Allowed Hours 
The sold hours for a job are derived from the DMS system and you would not normally need to 
change them. You should not make any changes before the information is received from the DMS 
system (IE the job is not in the Job Manager). By default TimePro will apportion the time allowed to 
each employee proportionate to the time each employee has had on that job. If the job is not in the 
Job Manager the time allowed will be the same as time taken (unless you choose that they be 
zero, see Import setup on page 17). 
 
Before making any changes, you need to consider what you want to achieve: 
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If you wish to change the total time allowed for the job, this is best done via the Job Manager 
screen (see page 11) 
 
If you wish to change the way the time has been allocated to each employee then: 
 

Choose ‘Job Number’ form the ‘Job’ dropdown box. Choose ‘All’ from the ‘Productive 
Status’ dropdown box.  
Enter the job number you are dealing with in the ‘Job Number’ box and press the enter key. 
All the clockings for the job will be shown in the grid. 
Open the job by clicking the  button on the lower toolbar. 
Click the  button on the lower toolbar of the Job Clockings screen. This will show the 
‘Update Sold Hours’ screen. 

 
 

The employees, who have worked on the job, are listed by the type of work done. As you 
click on each employee, the total time taken by that employee is shown. Enter the time sold 
by that employee and press enter. This will jump to the next employee. When all employees 
have been done, press enter or click the ‘Update’ button. TimePro will look through all the 
employees’ clockings, by sale type, and make any adjustment on the final clocking. 
 

When you have completed this process, TimePro will show in the status bar that ‘Calculate 
Required’ if you allow TimePro to recalculate, the changes you have made will be lost! To 
preserve your changes, you must lock the clockings (see other toolbar buttons on page 11) 

Closing Jobs 
A job will be ‘closed’ in TimePro automatically when all work has been completed on the job and 
the sold time information has been received from the DMS system. TimePro uses the open/closed 
status to determine the Work in Progress figures. You can Close a job that has been manually 
entered in the Job Manager by  clicking the  button on the toolbar. 
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Other Toolbar Buttons (Job Costing) 
 
Use the First, Previous, Next and Last buttons on the lower toolbar to move from Job to Job. 
 
The ‘Refresh’ Button shows the latest values, including changes made by other users on a 
network system. 
 
The ‘Calculate’ button will calculate the data to reflect any changes that are required if you have 
edited any data. You can see if this is required by looking at the status bar of the main screen, 
which will show the words ‘Calculate Required’. There is also a ‘Calculate’ button on the top toolbar 
that carries out the same function. TimePro will automatically calculate if it is required when you 
close the Job Costing screen. 
 
 
The ‘Multiple Job Number Change’ button allows you to change all records with a particular job 
number to another number (or non-productive code) and sale code. This may be required if you 
had issued a temporary job number for the employees to clock onto and now wanted to change the 
clockings to the correct number. Enter the job number you want to change from and the number to 
change to and the sale code. Click ‘Change’, you will be advised how many records will be affected 
and given the option to cancel. The changes will be recorded in the Job Audit. 
 
Lock Clockings   
 
On occasions you may wish to allocate time ‘sold’ to an individual employee on a different basis to 
that used by TimePro. Follow the procedure outlined in ‘Inputting Sold / Allowed Hours’. The 
clockings that exist at that time will now be set with the time allowed that you have just inputted. On 
the next clock download or calculate they would be overwritten. To prevent this happening you can 
‘Lock’ the clockings. 
 
The ‘Reset Job Close Date’ , from build 3.0.269, the date on which a job is closed is recorded. 
This is to allow the production of bespoke reports for some customers so will not be relevant to the 
majority of users. Use this button if you wish to change the ‘Close’ date 
 
NOTE: Right clicking the mouse can access many of the above toolbar functions. 

Job Manager 
The Job Manager is accessed by clicking the  button on the top toolbar. The Job Manager holds 
the information that is produced by your DMS system. TimePro calculates the time allowed for 
each job using the information from the Job Manager. If any errors are found, they are reported to 
you via the Exceptions screen / report. 
 

Importing Information from the AutoMate system into TimePro  
These toolbar buttons are used in the Job Manager screen when dealing with imported data:  

 
 
To import data from the AUTOMATE system you must first ensure that all attendance clockings are 
correct (except for the current day) and that any employees that have the default job set to ‘missed’ 
have had them reassigned to a job or non-productive activity. 
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Before importing data, review the exceptions screen and amend any obvious job number 
errors or change any temporary job numbers. 
 
Ensure the data file is available from your AUTOMATE system (the exact procedure for this will 
vary from system to system and this will have been advised at the time of installation) 
 
Click the ‘Merge Sold Hours’  button on the top toolbar. (This button is also on the lower toolbar 
of the Job Manager. The data will be imported into TimePro from the data file. TimePro will then 
automatically check for all clockings on the jobs you have imported and do the necessary 
calculations. TimePro will automatically close all jobs (that have been imported) that do not appear 
in the exceptions screen (see Exception Clockings on page 13) 
It does not matter if you repeat the action with the same file, TimePro will de duplicate any jobs. 
 
The above action will import data from the default location and file for the AUTOMATE system (see 
Import Setup on page 17) this default file is overwritten every time the DMS system produces its 
information. A backup file is produced with the date as the file name in case you miss importing the 

data for any reason. These files can be accessed via the ‘Open Import File’  button. Clicking 
this button will show an open file dialog box from which you can choose the file you wish to Import. 
Do not worry if you think that you may have already imported this data, TimePro will de duplicate 
any jobs for you. 

Inserting a New Job 
Normally, all jobs will be handled by the import routine. Occasionally, you may have to insert a job 
manually. After you have inserted the job, you should then calculate the data and close the job 
manually (TimePro will not close jobs that have not been imported) 
To Insert a new job, click the  button on the lower toolbar, enter a job number and click ‘OK’. 
TimePro will set up the job with one operation that is shown in the grid on the right of the Job 
Manager screen with operation code and the time allowed for that operation. To change the time 
allowed, click in the ‘Time’ column of the grid and type in the new time (in decimal, not hours and 
minutes). To change the operation, click in the grid column ‘Desc’, an arrow will appear at the right 
which will give a dropdown list of the available operations. 
 
The minimum data that is required for each job is: the job number, the operations that are to be 
carried out and the time allowed. The other fields such as customer, reference and comment are 
provided for your use. 

Adding Operations 
To Add Operations, click the  button on the lower toolbar. This will add a new operation to the 
grid. Change the operation type and time as described above. The total time for the job is shown 
above the grid. 

Deleting an operation 
Click the row in the grid that you wish to delete. Click the  button on the lower toolbar. 

Changing a Job Number 
To job number field is locked to prevent accidental over typing of the number. To unlock the field, 
click the button to the right of the field. After you have change the job number, save the changes by 
clicking the ‘Save’ button on the lower toolbar. To lock the field, click the lock button again. 
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Exception Clockings 
Every time new clockings are downloaded from the clock or TimePro calculates as a result of any 
changes the user has made, TimePro looks for clockings that do not match the data in the Job 
Manager. To view the exceptions clockings, click the  button on the top toolbar. This will show 
the Exceptions Clockings Screen. Each row in the screen is a clocking that TimePro has flagged 
as an exception, the reason for the exception is shown in the ‘Reason’ column. Remember that a 
row represents a clocking; therefore a job with six clockings will have six rows in the exceptions 
screen. 
 
Note: You can ‘sort’ the data in the exceptions screen by clicking on the header of the column you 
wish to sort by, clicking once will sort the data in ascending order, clicking again will sort the data in 
descending order. 
 
There are three reasons why a clocking may appear here: 
 

1. Not Received from AutoMate. There are two items to check: 
 

a. Is the job number accurate? If the number has been mis-keyed then you can correct 
it in the exceptions screen. 

 
b. If the job number is accurate, then the information has not been received from the 

AUTOMATE system. There will always be a delay between the employee clocking 
onto a job and that jobs sold / allowed hours information being provided by the 
AUTOMATE system, possible reasons will be the job is still in progress, the job has 
been held open whilst parts are ordered, the job has yet to be processed by the 
warranty clerk etc. You will have to decide at how old you let a clocking become 
before you investigate why no information has been received from the AUTOMATE 
system. TimePro has two tools to help you with this: 

 
i. You can tell TimePro to warn you if a clocking reaches a certain age (older 

than 20 days for example, see Import Setup on page 17). You can sort the 
data in date order to identify the older ones. Remember, that if the clocking 
is a genuine number and the information is regularly being imported into 
TimePro then the age of these clockings are a measure of the efficiency of 
your other systems. The longer it takes for a job to be costed; the worst your 
cash flow! 

 
ii. You can flag a clocking as having been reviewed by clicking on the last 

column on the exceptions screen and changing the ‘No’ to ‘Yes’ this is only 
an aide memoir and has no other function. It is simply designed to show you 
that you have looked at the clocking and are happy with it.  

 
2. Incorrect Sale Code. The job exists in the Job Manager but the clocking has used a 

different sale code. You need to be aware at what point in the invoicing stage that the 
AUTOMATE produces data for TimePro and also whether different operations can be 
included under the same job number: 

 
a. If a job number can only apply to one type of work (i.e. a vehicle that has both retail 

and warranty work involved would have two job numbers) then the clocking needs 
to be changed to reflect the information in the Job Manger. 

 
b. If more than one operation can be used under one job number you need to consider 

the following: Does the AUTOMATE system produce the information on that job 
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ONLY after ALL operations have been costed? If so, then the clockings must be 
wrong and you need to change the clockings operation number. If, however, the 
AUTOMATE system produces data as it is costed you may receive that information 
in stages (for example the retail element on one day and the warranty element in a 
few days time). In this case you will have to review all the clockings for the job and 
decide if more than one type of work is involved and whether the data is still to 
come from the AUTOMATE system. 

 
You can change the operation directly in the exceptions screen, click in the description field 
for the row that you are dealing with and click the arrow on the right of the field to get a drop 
down list, choose the operation that you require. If you want to know what information is in 
the Job Manager for a clocking, click on the desired row, right click the mouse and click on 
‘Job Manager Information’. Details of the operations and times will then be shown in a 
message box. 
 
If you double click the clocking in the Exceptions clocking screen, this will open up the Job 
Costing screen with the job you are working with. Holding the shift key down when you 
double click will open the Job Manger screen at that job. 
 
If you are leaving a clocking unchanged for any reason, you can flag a clocking as having 
been reviewed by clicking on the last column on the exceptions screen and changing the 
‘No’ to ‘Yes’ this is only an aide memoir and has no other function. It is simply designed to 
show you that you have looked at the clocking and are happy with it.  
 

3. Closed in Job Manager. The job has been closed. Go to the Job Manager and open the 
job. (This will normally only occur where you have inserted a job manually as TimePro 
automatically opens / closes jobs as required during the import process) 

 
After making any changes in the exceptions screen you will have to let TimePro calculate to put 
those changes into effect. 
 

TimePro and AutoMate Exceptions 
 
This section discusses the handling of exception clockings in TimePro. You may be happy to let 
TimePro / AutoMate deal with the clockings, if so you can ignore this section. However, if you want 
to understand what TimePro and AutoMate does, you will find this section interesting. 
 
The procedures outlined only apply to TimePro build 3.0.186 onwards; furthermore the output files 
from AutoMate must include the ‘Yes/No’ field. If in doubt about these, please contact the MMI 
Help Desk. 
 
Before looking at the exact processes carried out, it is important to understand how TimePro and 
AutoMate interact. 
 
TimePro, technicians clock onto the TimePro terminal using the last 6 digits of the AutoMate Job 
Number. They also enter a ‘Sale Code’; this is a 2-digit number being 10 for retail, 20 for warranty 
and 30 for internal work. A dealer may have additional Sale Codes if required, for example 40 for 
MOT. 
 
AutoMate uses the last digit of the Job Number to designate the type of work: 0 for retail, 1 for 
internal and 2 for warranty. 
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AutoMate produces information on sold hours for TimePro BY JOB NUMBER & SALE TYPE, 
TimePro tries to match Job numbers entered at the clock with Job numbers produced by 
AutoMate. It is obvious that if the Job Number and/or Sale Code information from AutoMate is not 
the same as the Job Number/Sale Code used at the clock they will not be matched. As you may be 
aware, AutoMate changes Job Number if the sale type changes. For example, a job may be issued 
as 123450 which is a retail job and the technician uses this at the clock with a Sale Code of 10. 
When the job is costed, it is changed to a warranty claim. The Job Number now becomes 123452 
and the sale type will be 20. We now have the following: 
 
 Job Number Sale Type 
TimePro  123450 10 
AutoMate  123452 20 
 
These are the same jobs, but to a computer they are two totally different jobs! And TimePro will 
show this as an exception clocking. Other errors are also possible, for example, the technician 
uses the correct Job Number but the wrong Sale Code is used. A job may also be ‘split’ i.e. it starts 
life as a retail job but it is invoiced to both retail and warranty. 
 
This causes a lot of work for the user and you can very quickly accumulate a lot of jobs with 
exception clockings that are time consuming to trace. 
 
As from TimePro build 3.0.186 a lot of the work with exception clockings will be done automatically, 
however! If the Job Number used by the technician is totally false (999999 etc) or a job is deleted 
in AutoMate there will never be a match! Therefore: 
 

1. Try to ensure the technician have the correct Job Number to hand when they clock on a 
job. 

2. NEVER delete a Job number (except when changing type of work) in AutoMate if a 
technician has used that Job Number. 

3. Before importing information into TimePro from AutoMate, review the exception 
clockings for obvious Job Number errors. (Missing first or last digit for example) 

 
TimePro uses two factors when trying to marry up exception clockings: 
 

1. It uses the ‘Core number’, in the example given above you can see that although the 6 digit 
numbers are different, the first 5 digits are the same. The 5-digit number is called the ‘Core 
Number’ in this document. 

 
2. When AutoMate produces information on a Job Number, it also includes a status flag which 

is either: 
 

a. Yes, this indicates that there is a work in progress job in AutoMate that uses the 
same Core Number 

b. No, the Core Number is not in use by AutoMate for any other jobs. 
 
When TimePro imports data from AutoMate, it carries out the following procedure with any 
exception clockings depending on why it is in the exceptions list. 
 
Incorrect Sale Code  
(Previously shown as, ‘Incorrect Operation Code’ up to build 3.0.190) 
If the job is complete (status flag No) TimePro will change the Sale Code used by the technician to 
match the Sale Code produced by AutoMate. If TimePro is unable to match the Sale Code used 
with the Sale Codes from AutoMate the clocking will be flagged as ‘Incorrect Operation Code’ 
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Action: User must review the clocking and decide on the Sale Code to be used. 
 
If the job is incomplete (status flag Yes), if other Core Numbers exist with the Sale Code used the 
clocking will be changed to that Job Number and recorded in the Job Audit as ‘Auto Exceptions’, 
otherwise the clocking will be flagged as ‘AutoMate WIP’ 
 
Action: No action should normally be required as the information will eventually come through 
from AutoMate, however, if the clocking becomes very old it should be investigated to see if the job 
has been deleted. 
 
Not Received from AutoMate 
(Previously shown as, ‘Not in Job Manager’ up to build 3.0.190) 
This means that no information on the Job Number has been received from AutoMate. It is 
important to remember that there will always be a certain amount of these due to normal 
work in progress and if the Job Number used by the technician is genuine then no further action 
is required other than to monitor the age of the clockings to see why it has not been costed in 
AutoMate. 
 
TimePro will process clockings in the following order: 
 

1. Try to match the Core Number, if not successful, leave as ‘Not in Job Manager’ 
2. If a match is made with the Core Number then: 

a. If the job is incomplete (Status flag Yes) then the clocking is flagged ‘AutoMate WIP’ 
b. If the job is complete (Status flag No) then TimePro will try to match with a core 

number using the same Sale Code as the clocking and change the Job Number of 
the clocking. If this is unsuccessful then a search is made to match the clocking with 
a Core Number/Sale Code based on the last digit of the clocking (0 for retail, 2 for 
warranty etc) if TimePro is still unable to match the Sale Codes then the Job 
Number / Sale code will be changed to the last match the last instance of the Core 
Number. All changes recorded in the Job Audit as ‘Auto Exceptions’ 

 
Action: Review older clockings and check why the job has not been processed in AutoMate. 
 
Finally, there may be occasions when a job has been clocked as only one type of work but is 
subsequently invoiced as more than one sale type. If this happens the technician will not be 
credited with the full amount of time. (Because a match will only be made with the Sale Code used 
by the technician). TimePro will look for sold time from AutoMate in the Job Manager where there 
has not been any clockings. TimePro will first search for the same Job Number (in the Job 
Manager) but different Sale Code and if found will add the time to that Sale code. If no match is 
found with the full Job Number, a search is made using the Core Number. If found, the time is 
added to the job. 
 
If more than one Sale Code is found, the time is split proportionately. 
 
The above does mean that the analysis of work by Sale Code may be slightly wrong but the overall 
figures will be accurate. Given the difficulties in manually tracking such instances we consider the 
slight error to be acceptable.  
 
If no match is found for a Job Number and Sale Codes from AutoMate, the Job is deleted from the 
Job Manager. 
 
You can print a list of the exceptions clockings by choosing the ‘Exceptions Report’ in the reports 
screen. 
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Other Toolbar Buttons (Job Manager) 
Use the First, Previous, Next and Last buttons on the lower toolbar to move from Job to Job. 
 
The ‘Refresh’ Button shows the latest values, including changes made by other users on a 
network system. 
 
The ‘Calculate’ button will calculate the data to reflect any changes that are required if you have 
edited any data. You can see if this is required by looking at the status bar of the main screen, 
which will show the words ‘Calculate Required’. There is also a ‘Calculate’ button on the top toolbar 
that carries out the same function. TimePro will automatically calculate if it is required when you 
close the Job Manager screen. 
 
The Search button can be used to search on Job Number, Customer or reference field. Click in the 
field you wish to search on and click the search button. Choose the required record from the list on 
type in the data you are searching for. 
 
The List button gives a list of jobs in the Job Manager with the customer and reference details. 
 
The Close button is used to close or re-open a job. This is only required on manually inserted jobs, 
as TimePro will automatically close imported jobs for you. 
 

End of Day Routine (AutoMate Integration) 
TimePro is designed to provide information for the AutoMate system. This is done by producing 
export files at the ‘Day End’. The format and information contained is these files are not user 
configurable. There are two ways to run the End of Day routine: 
 

1. Manually: This is done by clicking the  button on the top toolbar. You will be advised to 
run the routine only if all employees have clocked out for the day. Click ‘Yes’ to run the 
routine, you will then be asked if you want TimePro to close after the End of Day. Choose 
yes or no as applicable. TimePro will then download the data from the clock, calculate 
attendance and job data and produce the output file for AutoMate. 

 
2. Automatically: TimePro can run the End of day at a preset time (See export setup on page 

18) This allows you to leave the TimePro unattended and still be sure that the data has 
been produced for AutoMate. TimePro should be left running (only on PC that is connected 
to the clock), it will automatically close after the routine has completed. 

 

End of Day Errors 
You will be aware that TimePro would not normally process data where an employee has missed 
an attendance clocking. Should this have occurred on an End of Day routine, TimePro will make 
assumptions as to the total hours worked and the finish time of the last job based on the 
employees shift and day rules. This will allow AutoMate to process the data as near accurately as 
possible. You will be advised which employees had problems via the Export Exceptions Screen 
(click the  button on the top toolbar). If you have done a manual End of Day and chosen not to 
close TimePro, this screen will be shown automatically, otherwise, it will be shown the next time 
you start TimePro. 
 
Correcting Errors 
How you correct errors will depend on the circumstances under which the End of Day was run: 
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1. If you are viewing errors that have occurred on the current day, you should ensure that the 
employees have clocked out, or insert the missing attendance clockings via the Time & 
Attendance screen. You should then run a manual End of Day as described above. 

 
2. If you are viewing errors that have occurred prior to the current day. It is not possible to re-

export the data except on special circumstances. This is because the data will be 
duplicated in AutoMate. If, for any reason, you believe that AutoMate did not receive data 
for a particular date, contact the MMI Lynx Help desk for advice and follow the procedure 
below (Exporting Data when End of Day has not been run) 

 
Exporting Data when End of Day has not been run 
If an End of Day has not been run for any reason, you can manually export the data. Click the  
button on the top toolbar. Select the date required and press OK. You will not be allowed to run the 
routine if errors exist. 

Import / Export Setup 
The Import / Export Setup screen is accessed form the Job Manager screen by clicking the  
button. 
Some knowledge of the file produced by the AUTOMATE system is required when working in this 
screen.  
 
A full specification for the AUTOMATE file is shown on page 39 
 
These settings will be made for you when the system is installed and you should not make 
changes unless you are sure of what to do or are advised to do so by a software engineer. 
 
Import File Specification 
 

1. Includes Header Row, tick this box if the DMS output file has a header row before the data 
2. Lines Terminate with a carriage return, tick this box if each row in the output file ends with a 

carriage return character (13) 
3. Create Backup Files; if the DMS system does not provide a backup file when it produces 

the default file you can let TimePro do it for you. Each time you import data, a copy of the 
file will be made with the same name as the original file but with date and time added. For 
example a file called import.csv would be saved as 14-08-01 12-30-00 import.csv. 

4. Import File Location, this is the location that the DMS file is created. It may be on the 
TimePro computer, another PC or server on the local area network. Use the browse button 
if required. 

5. File Name, this is the name of the file produced by the DMS system (including the file 
extension such as .csv or .txt)  

6. Delimiter, select the delimiter that is used in the output file. 
7. Column Count, the minimum data that is required for each job is: the job number, the 

operations that are to be carried out and the time allowed (three columns) up to six 
additional columns can be used: 

 
a. Company Identifier (See Company Setup on page 31) 
b. Invoice Number  
c. Customer  
d. Reference  
e. Comment  
f. Invoice date  
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Select the number of columns that is used in the DMS File. For each column in the file, 
select the appropriate field from the Column Definition drop down boxes. 

 
If there are any errors with the import setup, TimePro will reject the records and record them in 
a file separate file. You will be advised that errors occurred and given the opportunity to view the 
file. A backup is also made of the import file that is prefixed with the date and time and the text 
‘Import Error’ 
 
 
Exception Clockings 

1. Warn when more than X days old. When TimePro calculates it will warn you of the number 
of jobs that exceed this age. 

2. Allowed Time. If a clocking is in the exceptions list, obviously TimePro cannot allocate any 
sold time to that clocking. As there will always be exceptions due to the time lag between 
the clockings and the job being costed you have two options regarding the allowed time for 
the exceptions clocking: 

 
a. Allowed time = time taken. This is the recommended option as the overall sales 

figures will include the exception clockings and time taken is likely to be nearer to 
the actual figure. 

b. Allowed time = zero. With this option all the exception clockings will be given an 
allowed time of zero. 

Auto Ignore 
If this box is checked, any exception clockings that are older than the days set will be automatically 
closed and taken out of the exceptions screen. This assumes that for some reason the sold hour’s 
data is not going to be available from AutoMate. 
 
Export Setup 
Click the Export setup tab: 
 

1. File path, this is normally the same as the Import file path. 
2. Auto Collect time. This is the time at which TimePro will automatically run the End of Day. 
3. Create Backup files, if this is checked, a backup of the export file is made (this is not 

normally required with AutoMate) 
4. Use Payroll Field as Employee ID. If the Technicians number in AutoMate is NOT the same 

as the clock number used in TimePro, this box must be checked and the payroll field in the 
Employee screen must have the same number that the employee uses in AutoMate. 

Viewing / Printing Reports 
 
Reports are accessed by clicking the  button on the top toolbar. 
 
A number or reports are available in TimePro. These are listed in the dropdown box entitled 
‘Available Reports’ and broadly fall into the following categories: 
    

1. Today’s Clockings 
This report shows the clockings for the current day. It is only as up to date as the last clock 
download. It shows each employees clockings, both attendance and job. No processing in 
terms of rounding or error checking will have been carried out. This reports is useful if the 
label printer fails and you need the current days clockings. 

 
2. Clockings / Attendance / Payroll 
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There are several reports giving clock readings, payroll and absence information. 
 

3. Performance Summary 
This is one of TimePro key reports. It only includes productive employees and summarises 
the attendance and job performance as well as showing labour sales and cost by sale type. 
 

4. Job Costing / Performance Reports 
 

There are several reports that give information on job based work and non-productive 
activities. There are also Gross Profit and Work in Progress reports. 
 

5. Shift, Day & Overtime 
 

This reports lists all the settings for the Time and Attendance setup. 
 

6. Bespoke Reports 
 

Any reports that have been created by MIM Systems for an individual customer will appear 
at the end of the Available Reports list. 

 

Filtering the data for reports 
There are a number of criteria that can be used to filter the data used in the reports. These are 
shown on the reports screen and are divided into two categories, General Options and Job Costing 
Options. If criteria are not applicable to a particular report, it will be disabled and ‘greyed out’ to 
prevent you using it.  
 
On the General Options tab you set options for Companies, Groups, Date Range and Employees. 
 
For companies and date options, select the desired criteria from the dropdown boxes. If you 
choose custom dates, you can then set the ‘From’ and’ To’ date using the dropdown calendars.  
For the groups, the default is All groups, to select individual groups, uncheck ‘All Groups’ and tick 
the box(s) next to the desired groups. 
To select individual employees, click the Select button and choose the desired employees from the 
list (a maximum of 20 employees can be selected). 
 
On the Job Costing Options you can set options for Job Status, Sale Types and Job Number(s). 
Job Status can be set to ‘All’, ‘Open’ only or ‘Closed’ only. 
Sale Types default to ‘All’ or you can select individual types (see groups above). 
Job Numbers default to ‘All’. To show just one job number, type the number on the Job Number 
box. To use a range of job numbers type the lowest and highest in the ‘From’ and ‘To’ boxes. 
The ‘Select’ box will give you a list of all job numbers for you to choose from. 
 
Remember that non-productive codes can be used wherever you use Job Numbers. 

Toolbar Buttons (Reports) 
 
The three buttons are: 

1. Close, close the Reports Screen 
2. Print, This prints direct to the printer, we suggest you preview the reports first as some 

reports can be several pages long. 
3. Preview, Shows the report on screen, you can then print the report be clicking the printer 

button at the top of the preview screen. 
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Employees 
Click the  button on the top toolbar to view the Employee screen. 
The screen has two tabs: 

Employee Tab 
The employee tab has the following fields: 
  

1. Number 
This is a unique number given to the employee when he is set up in TimePro, it cannot be 
changed. 
 

2. Status 
An employee can be either ‘Current’ or on ‘Hold’. Hold should be used where an employee 
has left and may return, maternity leave for example, or the employee has left and you wish 
to retain the data for him. TimePro will not generate any new records for an employee that 
is on hold. If you delete an employee, you will loose all data for that employee. 
 

3. Full Name 
This is the full name of the employee. It must include one space so avoid using just first 
name or last names. 
 

4. Clock Name 
This is the name that will be used at the clock terminal(s) when the employee clocks in and 
out. The maximum length is 18 characters and must include one space. If you change the 
full name, TimePro will automatically create the clock name and if the full name is greater 
than 18 characters, will abbreviate it. You can change the abbreviated name if you wish. 
 

5. Clocks 
If you only have hard-wired clocks, leave this at ‘All Clocks’. If you have modem clocks as 
well, you can choose whether the employees name will be sent to all clocks, hard-wired 
clocks only or a specific modem clock. (See ‘Send Names’ on page 25) 
 

6. Shifts Group 
This is the Shift Group that the employee belongs to. (See page 35) 

 
7. Overtime Rule 

The overtime rule that the employee works under. (See page 31) 
 

8. Group 
The employee group that the employee belongs to. (See page 31) 

 
9. Default Job 

If an employee does not clock onto a job within the time set for AutoClock (see page 37), 
TimePro will ‘Clock’ an employee onto his default job. You can choose any of the non-
productive activities so a supervisor can be clocked on to Supervising or an apprentice onto 
Apprentice. For a normal productive employee we suggest you use ‘Missed Clocking’. This 
will tell you that an employee forgot to clock on a job and give you the choice of what to 
clock him onto. (See ‘Screen Layout’ under ‘Checking / editing the Job Costing Data’ on 
page 8) 
If the employee does not clock on and off jobs, set this to ‘Non Productive’. 
 

10. Non Productive Factor 
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If an employee clocks on and off jobs but is considered to be only part productive, because 
he is a supervisor or an apprentice for example, TimePro will factor his time worked on jobs 
to account for this. (This applies only to the ‘Performance Summary’ Report). Enter the Non 
Productive factor. 

Confidential Tab 
The confidential tab has the following fields: 
 

1. Basic Pay 
This is the basic hourly rate for the employee. If this rate is not entered, the job costing and 
payroll reports will not be accurate. 
 

2. Holiday Entitlement 
At the beginning of the holiday year, enter the entitlement for the employee; TimePro will 
reduce the figure as you book holidays. 
 

3. Payroll Number 
This can be used for a payroll code; it defaults to the employee number but should be set to 
the same number that the employee has in AutoMate (productive employees only) 
 

4. Start and Finish Dates 
Set the start date to the employee start date. The finish date should be set to the same as 
the start date until the employee leaves when it should be set to his actual leave date. 
 

5. Notes 
This is a free field for any information you may wish to record about the employee. 
 

Adding a New Employee 
To add a new employee, click the  button on the lower toolbar. Enter a unique number for the 
employee. You are recommended to use numbers between 100 and 995, however, TimePro will let 
you use a lower number but will warn against it. 
 
Enter the full name for the employee, when you move to the Clock Name field, TimePro will 
automatically enter this for you. Select the appropriate options for the employee for Shift Group, 
Group, Overtime Rule and Default Job. Complete the appropriate details on the ‘Confidential’ tab. 
 
Punch out an Attendance and, if required, a Job badge. 
 
You can print badge label(s) for the badges. (See ‘Other Toolbar buttons’ on page 23) 
 
Go to the Clock Screen and ‘Send Names’ (See ‘Send Names’ on page 25) to the clock(s) so that 
the employee will be recognised when he starts to use the clock. 
 

Deleting an Employee 
An employee should only be deleted if you are happy to loose all the data for that employee. If you 
wish to retain the data it is recommended that the employees status be set to ‘Hold’ (See ‘Status’ 
on page 21) 
 
To delete an employee, click the  button on the lower toolbar. 
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Other Toolbar Buttons (Employees) 
 
Use the First, Previous, Next and Last buttons on the lower toolbar to move from Employee to 
Employee. 
 
The Print Badge Labels button will show a screen that allows you to print badge labels. Choose 
‘Attendance’ of ‘Job Badge’ under ‘Type’. If you want just a particular employee, uncheck the ‘All’ 
box and check the employee(s) required. 
 
You should use Avery ™ J8651 labels or equivalent which have 65 labels in five columns and 
thirteen rows on each sheet. (You can obtain these labels from MIM Systems in single sheets). If 
you are using a part used sheet of labels, set the column and row that you want to start printing at. 
 
You can preview the labels on screen or print direct to the printer by clicking the appropriate button 
on the lower toolbar of the labels screen. 
 
The Search or find button allows you to search for an employee by name. Double click on the 
desired name in the list or start typing in the name of the employee. TimePro will move to the 
employee you are searching for. 
 
The Input Basic Pay and Holidays screen allows you to input pay and holiday entitlement for all 
employees via a single screen. 
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Advanced Operations 

System Setup 
The System Setup screen is accessed form the ‘File’ menu. 
 
The following settings can be made: 
 

1. Database Location 
This is the location of the TimePro databases. On a single computer system this will 
normally be C:\TimePro NG\Database. If TimePro is being used on a network, this will be 
the path to the computer of server that has the TimePro database files. The database files 
are called TPro2000.mdb and TimePro.mdb. 
Use the ‘Browse’ button to set the location. 
 

2. Backup File Location 
TimePro creates a backup file on shutdown; you can select a different location (for example 
on a server) for this file 
Use the ‘Browse’ button to set the location 
 

3. Portable Files Location 
This is the location for files used with the Portable units. (Please see separate instructions 
on the Portable units) 
 

4. Clock Files 
When data is downloaded from the clock(s), it is saved in a file (see ‘Clock Files’ on page 
25). These files are saved in the location set here. 
Use the ‘Browse’ button to set the location. 
 

5. Archive Files 
This is the location for Archive files. (See ‘Archiving Data’ on page 27) 
Use the ‘Browse’ button to set the location. 
 

6. Days to Archive 
TimePro will use this setting when you create an Archive file. (see ‘Archiving Data’ on page 
27) This is the age, in days, over which you will archive data. For example, if it is set to 120, 
all data that is OVER 120 days old will be saved in the Archive file. All data that is UNDER 
120 days old will be left in TimePro. 
 

7. Use This Computer for Backup and Compact 
At least one of the computers running TimePro must have this option checked. If possible, it 
should be the computer that the databases are located on. 
 
With this option checked and TimePro is shut down, provided no other computers have 
TimePro running, the database files will backed up to two files called TPro200.bak and 
TimePro.bak in the same location as the database files. (See ‘Restoring a Backup’ on page 
28 for details on restoring the backup files) 
 

8. Warn if Backup File cannot be created on shutdown 
This option should be selected if TimePro is used on a network and the databases are also 
located on a TimePro PC. If this option is selected and a backup cannot be created 
because another user is logged into TimePro a warning will be given not to shut down the 
computer. 
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9. This computer is connected to the Clock(s) 

Check this box if the computer is connected to the clocks. 

Clock Operations 
As well as the normal collection of data from the clocks, a number of other actions can be 
performed. These are accessed from the dropdown box at the top left of the Clock Actions screen. 

Clock Files 
When data is downloaded from the clock(s), it is saved in a file with .dat extension. The files are 
located in the folder set under ‘System Setup’ (See page 24). The name of the file will be the date 
the collection was made together with a number indicating the order that the file was created. The 
first will on any date will be 0 the second 1 etc. For example, ‘Dec 22 2000 0.dat’. A letter ‘M’ 
before the sequence number indicates it is a modem collection and the letter ‘E’ indicate that it is 
an emergency collection. 
 
These files can be viewed / edited from the clock screen (see ‘Other Toolbar Buttons (Clock 
Screen)’ on page 26)  
 
The clock screen displays all data that is being sent and received to / from the clocks. 

Normal Collection. 
See ‘Communicating with the clocks(s)’ on page 3 

Emergency Collection 
Every time you download data from a clock, a copy of that data is kept in a second memory 
in the clock. Should a problem occur with the download and data is lost for some reason, 
you can use the Emergency Collection to get a copy of the data. 

Set Clock Time 
The time / date of the clock(s) can be set. The time and date used will be that of the 
computer so ensure it is accurate before carrying out this operation.  
 
TimePro will wait until a full minute is reached before setting the time. 

Send Names 
The names of all employees are stored in the clock(s). You should use this operation when 
a new employee is added in TimePro. It is recommended that a normal data collection be 
carried out before this action is done. 
 
After the clock has been programmed with the names, the clock will be set to reject any 
unknown employee badge or number. (See ‘Toggle List Exclusive’ below) 

Test Collection 
This will carry out a normal clock download but will not clear the clock memory or process 
the data. 

Memory Clear 
THIS WILL CLEAR THE MEMORY IN THE CLOCK(S). Use this action with care, it is 
designed for deleting the memory after repair work or testing the clock and should not be 
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used under normal circumstances. TimePro will automatically clear the memory after a 
successful normal download. 
 

Toggle Exclusive List 
When the clocks are programmed with the employee names, the clocks are set to 
‘Exclusive’. This prevents an unknown badge or number being used. Using ‘Toggle 
Exclusive List’ you can switch this option on and off. Use once to switch on; use again to 
switch off etc. 

Check Serial Number 
Each clock has a unique serial number. If this number is required you can use this action to 
retrieve the number without physically inspecting the clocks.  

Other Toolbar Buttons (Clock Actions) 
The Clock / Modem Setup button will show the Clock Setup screen, the following settings can be 
made: 
 

1. Number of Hard Wired Clocks 
2. COM Port of the Hard Wired Clocks 
3. COM Port used for the modem (if used) 
4. Timeout time in seconds 

This is the time that TimePro will wait if there is a break in data transfer; it is normally set to 
15 seconds. This time is automatically increased by 10 seconds when a modem is being 
used. 

5. Baud rates for the hard and modem COM ports. This is normally 1200. 
6. Do not clear clock memory 

This option is normally used for testing purposes only. If checked, the clock memories will 
not be cleared after a download. Use this option when advised by Technical Support. 
 

The right hand side of the screen shows details of any modem clocks that are used. To add a new 
modem clock, click the ‘New’ button on the lower toolbar and type in a description for the clock 
such as ‘Workshop’. The new clock will be shown in the grid. Enter the phone number for the clock 
in the right hand column. 
 
Other options for modem set up are: 
 

1. Outside Line 
Check this option if the phone line is accessed via a switchboard, you will also need to set 
the number that needs to dialled for the line. 
 

2. No Dial Tone 
This should be checked if the phone line does not produce a dial tone. 
 

3. Modem Initialisation String 
TimePro uses this information to configure a modem prior to dialling a remote clock. Any 
changes to this setting should be made with care. The last 2 characters should always be 
X4. If you wish to return to the original settings, click the ‘Restore’ button.  
 

The Open Data File button will show the open file dialog box. Use this option if you wish to load 
clocking data direct from a file. This would only normally be done where the data file has been 
edited or copied form another computer. 
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View Collected Clocking Files. The clock files can be viewed and edited via this screen. The 
screen lists the clock files in descending date order but in ascending collection order. The right 
hand column gives a description of the type of file. (See ‘Clock Files’ on page 25) 
 
The files can be viewed and edited by clicking the ‘View / Edit’ button on the lower toolbar. 
 
The files can be reloaded into TimePro by clicking the ‘Reload Clock File’ button. Reloading the file 
will not cause any harm as any duplicates will be ignored, however, any clockings that you may 
have deleted in TimePro will be reloaded. 
 
You may see a file called ClockError.txt. TimePro creates this file if it detects an error with the data 
as it is downloaded from the clock(s). This can happen if electrical interference occurs or, if using a 
modem, there is interference on the phone line.  
TimePro will advise you of this at the end of the download process and give you the opportunity to 
view the error. If you view the file it will look something like this: 
 
� � 21/11/00 18:07:39 
Correct Format 
##345678 dd DDMMYY  HHMM 
Actual 
00000054 TU 21110  1613  
------------------------  
 
The first line shows the date and time that the error occurred. 
The line under ‘Correct Format’ shows what TimePro was expecting to find, in this case this is an 
attendance clocking. The first 8 characters are the employee number, the next 2 are letters 
denoting the weekday followed by 6 characters for the date (ddmmyy) and finally the last 4 
characters are the time. 
 
The last line will show what TimePro actually got. In this case, you can see that the last ‘0’ is 
missing from the year. You can edit the file to correct the error and then save it. Make sure that the 
actual line is the same as the correct line in all respects including spaces in and at the end of the 
line. You should then reload the file using the procedure described on page 26 (View Collected 
Files) 
 
A job clocking is similar to the attendance clocking but has extra characters for the job number and 
sale type. 

Archiving Data 

Creating an Archive 
As time passes, the data held by TimePro will increase. This will slow down the calculation times, 
as more and more data has to be processed. Old data can be archived to a file. In this way, the 
data is not lost and can be viewed when required. (See ‘Opening an Archive File’) 
 
When you create an archive file, all data that is over the age set in System Setup (see page 24) is 
saved to the archive file. From the ‘File’ menu, choose ‘Create Archive’. This will show a save file 
dialog box, enter a name for the file such as ‘Data up to 1-3-00’ and click ‘Save’. This operation 
can only be completed if the only user is the one creating the archive file. If TimePro is in use by 
other users on a network you will get a message to tell you that the operation could not be 
completed.  
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Opening an Archive File 
To open an archive file, choose ‘Open Archive File’ form the ‘File’ Menu. To return to the current 
data, choose ‘Return to Current Data’ form the ‘File’ menu. 
 
If TimePro detects that the archive database needs upgrading, it will do this automatically when 
you open the archive file. 

Backup 

Creating Backups 
There are two forms of backup that should be considered with TimePro: 
 

1. TimePro Backup 
When TimePro shuts down, backup files are automatically created (see ‘System Setup’ on 
page 24). This operation is only run from the computer designated for that purpose and 
only if no other users are running TimePro. 
 

2. User Backup 
As the TimePro backup is on the computers hard drive, should the hard drive fail, both the 
original and backup could be lost. It is strongly recommended therefore, that users keep a 
backup of the data to an external device such as a Zip or Tape drive. Use the backup 
software for the device to backup the files TPro2000.mdb and TimePro.mdb. These files 
are located in the database folder as set in ‘System Setup’ 9 (see page 24) 

Restoring a Backup 
To restore the TimePro backup, choose ‘Restore Backup’ from the ‘File’ menu. (See also 
‘Database Repair’ on page 30) 
 
To restore a User Backup, follow the instructions of the Zip or Tape software. 

Security 
By default, security is switched off. To activate security protection, choose “Password” from the 
setup menu. This will show the change password screen. You will notice that the user is ‘master’ 
and that the ‘Old password’ box is greyed out. To activate security, a password must be assigned 
to user ‘master’ this is done by entering a password in the ‘Password’ box and re-entering the 
same password in the box below. NOTE: passwords are CASE sensitive. 
 
A senior person such as the department manager should carry out the setting of the 
password for user ‘master’. The password should be carefully recorded, as it will only be 
used to log on to TimePro to assign or delete other users, set permissions or to disable 
security.  

Setting up users 
Once a password has been assigned to user ‘master’, close TimePro and restart. You will now see 
a log in dialog box. Enter ‘master’ (lowercase and without the quotes) in the User Name box and 
the password you created earlier. 
 
From the ‘File’ menu, choose “User Admin”. (This operation is only available if you log on as user 
‘master’).  From here you can create new users and delete existing users. 



TimePro     

Copyright MIM Systems Ltd 2000 – 2004 TimePro is registered Trade Mark of MIM Systems  Page 29 

To create a user 
1. Enter the password for ‘master’ 
2. Enter a name for the new user 
3. Enter a password for the new user 
4. Re enter the password 

 
(Note: User names and passwords can be any combination of letters or numbers but must be at 
least four characters and no more than ten characters. User names and Passwords are CASE 
sensitive) 
 
Click the ‘Add’ button. A message will advise that the user has been added to the user list. To 
maintain security, the new user should log on to TimePro and change his password to a password 
known only to that user. 
 
A list of users is available by clicking the browse button next to the User Name box. 

To Delete a user 
1. Log on as User ‘master’ and go to User Admin. 
2. Enter the password for ‘master’ 
3. Enter the User Name or select it from the list 
4. Click the ‘Delete’ button. 

Changing a Password 
If you need to change a password, log on as the User you wish to change the password for, select 
‘Password’ from the ‘File’ menu. Enter the old and new passwords as required. 

Forgotten Password 
If a user has forgotten their password, log on as ‘master’, delete the user and recreate as a new 
user. 

Disable Security 
Log on as User ‘master’, select ‘Password’ from the ‘File’ Menu. 
Enter the old password for ‘master’. DO NOT enter anything in the new password boxes. Click ‘Set’ 

User Permissions 
Once a user has been created, you can set permissions for that user. In this way you can restrict 
what a user can do and see in TimePro. 
 
You must be logged on as ‘master’ to set permissions. 
Choose ‘User Permissions’ from the ‘File’ menu. 
 
At the top of the Permissions screen is a dropdown box with a list of all users. Choose the user you 
wish to set permissions for. 
By default, a user has permission to do everything in TimePro. Uncheck the items that you do not 
wish the user to have access to. When you have set permissions for all users, close the 
permissions screen. 
 
The user permissions will take effect the next time a user logs on. 
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Database Repair 
Occasionally, the TimePro databases may become corrupted. A computer being shut down when 
TimePro is still running usually causes this. Always ensure that all programmes are shut down 
before a computer is powered down. 
  
If a database is corrupted you will probably be unable to start TimePro and will get an error 
message. Go to the windows start button, go to Programs and then to the TimePro NG folder. Click 
the ‘Repair Utility’ icon and follow the instructions. 
 
If a database cannot be repaired, you will need to restore the backup file. This must be done by 
running the Repair Utility on the computer that is used for TimePro backup. 
Run the Repair Utility, click the button ‘Restore Backup’ you will be advised of the date and time of 
the available backup. If you restore the backup, the original database file will be backed up. 
 
After you have restored a backup, you will have to reload any clock downloads carried out since 
the backup (see Viewing Clock Files on page 26) you will have lost any data such as Sold Hours, 
New Employees etc that had been created since the backup. 

Updates to the TimePro software 
Software updates will be issued to you when required. This will be by CD Rom or floppy disc. 
Any update must be run on ALL COMPUTERS THAT HAVE TIMEPRO INSTALLED. 
 

1. ENSURE TimePro IS NOT RUNNING ON ANY COMPUTER 
2. Insert the CD or floppy disc as applicable 
3. Go to the TimePro NG folder on the Program Menu. Click the ‘Update Utility’ icon 

This will start the TimePro Update Programme 
4. Choose the update source (CD or Floppy disc) from the dropdown box. If you are using a 

CD or Floppy on another computer on a network, check the ‘Use Network PC / Server’ box 
and use the ‘Browse’ button to locate the network source. 

5. Click Update 
6. Wait until the progress bar has completed and a message box advises that the update is 

complete 
7. Repeat the above an all computers running TimePro 
8. If the update fails for any reason, contact MIM Systems for advice 

Configuration of TimePro 
Before dealing with the details of the shift setup, please consider the following and how it applies to 
your company. Please take some time to study these carefully. They will help you to understand 
the way TimePro works. 

Companies / Groups / Rates of Pay 
To access Companies and Groups setup, click the  button on the top toolbar. 
 
Normally, there will only be one company but you can have multiple companies each with their own 
groups of employees. However, all companies must use the same pay multipliers (see Rates of 
Pay) 
 
Each company can be divided into groups for reporting purposes. These may be logical groups 
such as Office Staff and Productive Staff or could be teams of people within the same department. 
An employee can only belong to one group. 
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Up to five rates of pay are available, rate one is basic i.e. a multiplier of one. Typically you would 
have Time and one third, Time and one half and Double time but you can use any multiplier for the 
other four rates. 
 
The screen has two tabs: 
 
Companies / Groups Tab 
The left hand grid shows the companies (there must be at least one) together with the ID of the 
company. In the right grid is list of groups and the company ID of the company each group belongs 
to. 

To add a new Company or Group 
Click the ‘New’ button on the lower toolbar. Choose company or Group as applicable and type a 
name for the new Company / Group. 
If you have created a new group, click on the Company ID column in the group grid and assign the 
group to the correct company. 

Company Alias 
This field is for use with the DMS Import (See Import Setup on page 17) If the imported information 
from the DMS system includes an identifier for the company then this should be entered in the 
alias field. It can be a number or text up to 30 characters.  

To delete a Company or Group 
Click on the Company or Group that you wish to delete and click the ‘Delete’ button on the lower 
toolbar. TimePro will not allow you to delete a Company or Group that is in use. 
 
Defaults Tab 
On this tab you can set the rates of pay and their multipliers. Rate 1 should always have a 
multiplier of 1; the other rates can be anything you choose. These rates are used in the Day and 
Overtime Rules. 
 
The Last Day of Week should be set before you use TimePro for the first time. This is the ‘Last’ 
day of your pay week. 

Day Rules, Shifts, Overtime and Shift Groups 
The setup screen for the above is accessed by clicking the  button on the top toolbar. 
The setup screen has the following tabs: 
 
Default settings. You will notice that there is a ‘Default’ for all of the above. TimePro uses these 
when setting up a new employee. You can modify them if you wish but it is recommended that you 
create your own rules etc. 

Overtime 
Two types of overtime rules are available in TimePro: 
 
Daily Overtime 
An employee is paid overtime on a day-by-day basis, for example, the working day is eight hours 
and the employee works ten hours. He is paid two hours overtime regardless of the total hours 
worked for the week. 
 
If you only use Daily overtime then you do not need to create any overtime rules as this is dealt 
with under the Day rules. (See ‘Day Rules’ on page 32) 
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Weekly Overtime 
If an employee has to reach a weekly target before he is paid overtime, for example, on a forty 
hour week overtime only starts to be paid after forty hours has been worked irrespective of the 
hours worked on a day by day basis. 
 
It is possible to specify exception days (up to three) for example Saturdays and Sundays, when an 
employee will be paid at overtime rates even though the target has not been met. 
You can have as many weekly rules as you wish, for example, a weekly rule with a target of twenty 
hours for part time staff and a weekly rule with a target of forty hours for full time staff. 
 
Note: 
An employee can only have one type of overtime but you can have different employees on different 
rules, for example, office staff may be on a weekly rule whilst productive staff could be on a daily 
rule. 
 
To Create an Overtime Rule, click the ‘New’ button on the lower toolbar and enter a meaningful 
description such as ‘Weekly 40’ 
 
Enter the hours (in decimal) to pay at each rate. For example, 40 hours at rate 1, 20 hours at rate 2 
etc. 
 
If you wish to apply Daily Overtime on specific days. Choose the days from the dropdown boxes. If 
you want the weekly target to be reached first, check the ‘Hit Target First’ box. If you use this 
option, make sure that the Day Rules for these days are set up with the hours and pay rates that 
you wish to pay. 
 
If you want to enforce Time Banding (see ‘Day Rules’ on page 32) from the Daily Rules, check the 
‘Force Time Band Rules’ box. 
 
The ‘Week Ends’ Time denotes the time, on the last payday of the week that the week ends. Any 
work after that time will be carried forward to the next pay week. 

Day Rules 
A Day Rule is required for each type of ‘Day’ an employee could work. 
The number of Day Rules you require will depend on the complexity of you working patterns. There 
follows two examples that will help to illustrate this: 
Example One, Simple 40 Hour week. 
Employees work Monday to Friday with the same start and finish times. On a Saturday, they work 
only the morning. 
 
In this example only two ‘Day Rules’ would be required: 
 
 Day Rule One: Mon to Fri 
 Day Rule Two: Saturday 
 
Example Two, Early and Late Shift each day, shorter day on Friday. 
Employees can work Monday to Thursday on either an early or late shift. On Friday, the working 
day in one hour less. On a Saturday, they work only the morning. 
 
This would require the following Day Rules: 
 
 Day Rule One: Mon to Thur, Early shift 
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 Day Rule Two: Mon to Thur, Late shift 
 Day Rule Three: Friday, Early shift 
 Day Rule Four: Friday, Late shift 
 Day Rule Five: Saturday 
 
To Create a Day Rule, click the ‘New’ button on the lower toolbar and enter a meaningful 
description, for example, ‘Productive Early’ 
 
The basic elements of a day rule are: 
 

1. Start Time: The start time for the day e.g. 08.00. 
 
2. Finish Time: The finish time for the day e.g. 17.00. 

 
3. Overtime Start before shift: When do you want to pay overtime to someone who clocks in 

before shift start? For example, on a shift start of 08.00, setting this to 07.30 will only pay 
overtime if an employee clocks in before 07.30, if he clocks in after 07.30 he will be paid 
from 08.00. 
If this field is left blank then the employee will not be paid until the start time regardless of 
when he clocks in. 
If it is set to the same time as the start time then the employee will be paid overtime from 
when he clocks in (subject to grace and rounding rules) 
 

4. Overtime Start after shift: How much time do you want to allow after the shift finish time 
before overtime kicks in? This allows for cleaning up etc and is typically 15 minutes. 

 
5. Minimum Time to Work before overtime Starts: Enter the minimum time in hours and 

minutes, that an employee must work before getting overtime. TimePro will compare the 
total time worked against this setting and the value set in the Hours to Pay at Rate 1 (or 
Rate 2 if Rate 1 is blank, Rate 3 if Rate 2 is blank and so on). If the total time worked is 
greater than the Rate time but less that the Minimum Time to Work, then the total time is 
reduced to the Rate Time. Leave this setting blank if you wish the employee to move onto 
overtime as soon as the Rate time is exceeded. This setting is not applicable to Day Rules 
that go over midnight. 
If using this setting on a Day Rule that applies to an employee on a Weekly Overtime 
Rules, you would normally set Rate 1 to 23:59 but for this facility to work you must setup 
Rates 1, 2 etc as for a normal Day Rule 
If you use this option with an productive employee you need to be aware on the effect it has 
when producing the Performance Summary Reports. On these reports, you will see a 
column 'Unpaid Hours'. This is the time deducted from the attendance time by enforcing 
this option. The value of the Unpaid Hours is also deducted from the Productive Time (Time 
clocked on Jobs) for the employee. This is to ensure the Utilisation, Productivity and 
Efficiency calculations are meaningful. 

 
6. Paid absence hours: If an employee is absent and is to be paid (e.g. Holiday) the number 

of hours to pay. (TimePro uses the first day rule that an employee could have worked for a 
given day, see ‘Shift Groups’ on page 35) 

 
7. Grace Times: How many minutes grace on clock IN and OUT (they can be different for IN 

clockings and OUT clockings but all IN’s will be the same as will all OUT’s) 
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8. Rounding Times: If the grace period is exceeded, what rounding to apply? For example 15 
minutes. (Again, they can be different for IN clockings and OUT clockings but all IN’s will be 
the same as will all OUT’s) 

 
9. Flag if Early Finish, Late Start or Absent: the TimePro reports can show if an employee 

has started late, finished early or was absent on the day. Click the check boxes as 
applicable. 

 
10. Hours to Pay at Rate 1,2,3,4 and 5: This is applicable to Daily Overtime Rules AND 

exception days for Weekly overtime. Enter the hours to pay at each rate, for example, the 
first eight hours at rate one, the next two at rate two, the rest at rate three etc. if this is a 
Weekly Overtime day it will be 23.59 hours at rate one. (Unless using the Minimum Time to 
Work option) 

 
11. Time Banding: You can specify a different rate of pay if an employee works between 

certain times, for example, if he works between 05.00 and 08.00 in the morning, pay at rate 
two irrespective of overtime rules. 

 
12. Cash Adjustment If a shift allowance or other payment is to be made if this shift is worked, 

enter the amount and reason.   
 

13. Deduct Break: If you do not want an employee to clock OUT and IN for an unpaid break, 
enter the minutes to deduct. Note: This time will always be deducted irrespective of whether 
it was actually worked on not. Productive employees (employees who clock on and off jobs) 
must always clock breaks to ensure accurate job times, so you should NOT use this option 
on a day rule that is to be used by productive employees. (See also AutoClock Break) 

 
14. AutoClock Break Normally, productive employees should clock OUT and IN for lunch 

breaks, however, if this is not possible you can set an OUT and an IN time for the break in 
the day rules. Clockings will be automatically entered the first time a day is calculated. If 
you subsequently delete the clockings, they will not be reapplied during calculation. Be 
aware that the job clockings shown in the TimePro reports WILL NOT marry up with the 
labels produced by the clock terminal as the label will include the time taken for the break. 

 
15. Allow Flexi Breaks By default, the Rounding settings are applied to all attendance 

clockings. This can cause problems if you wish to use roundings of, say, 15 minutes but 
wish to allow employees to clock lunch breaks on a flexible basis, for example 12:10 to 
12:40. If 15 minute roundings are used here, the employees clockings will be rounded to 
12:00 and 12:45. By selecting 'Allow Flexi Breaks' all attendance clockings EXCEPT the 
first and last clocking of the shift will be rounded to 5 minutes. If you use this option, the 
Grace on IN and Grace on OUT should be less than 4 minutes 

Shifts 
A ‘Shift’ consists of a set of Day Rules, Monday to Sunday. In the examples given earlier: 
Example One (Simple) 
 
Only one shift is required: 
  

 Shift One Day  Day Rule 
    

Mon  One 
   Tue  One 
   Wed  One 
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   Thu  One 
   Fri  One 
   Sat  Two 
   Sun  Default1 

 
Example Two (Complex) 
 
Two Shifts would be required: 
  

Shift Early Day  Day Rule 
    

Mon  One 
   Tue  One 
   Wed  One 
   Thu  One 
   Fri  Three 
   Sat  Five 
   Sun  Default1 

 
Shift Late Day  Day Rule 

    
Mon  Two 

   Tue  Two 
   Wed  Two 
   Thu  Two 
   Fri  Four 
   Sat  Five 
   Sun  Default1 

 
To Create a new Shift click the ‘New’ button on the lower toolbar and enter a meaningful 
description such as ‘Early Weekday’ 
 
In the grid at the right of the screen you will see a list of weekdays. Against each day, click on the 
dropdown box and choose the Day Rule that you wish to use for that day. 
 
Repeat the above for all the Shifts that you require. 
 
If a shift goes over midnight, check the ‘Shift goes over Midnight’ box. You will also need to enter 
the overflow time. This is the time, in hours and minutes that TimePro will look after the shift end 
time for the last OUT clocking. If an OUT clocking is not found in that time you will get an ‘Uneven 
Clockings’ message in the Status column on the Time and Attendance screen. 
 
To Delete a Shift, click the ‘Delete’ button on the lower toolbar. TimePro will not allow you to delete 
a Shift that is in use. 
 

Shift Groups 
 
The last element is the ‘Shift Groups’. This is where TimePro can work out which shift and day rule 
to place an employee in based on the first IN clocking of the day, using the examples given before: 
 
Example One (Simple) 
                                                 
1 A Default Rule is provided for days that are not normally worked 
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The Shift Group would be: 
 
Clock IN Time Until:   23.59 
Use Shift:   One 

 
Example Two (Complex) 
 

The Shift Group would be: 
 
Clock IN Time Until:   11.00 
Use Shift:   Early 
 
Clock IN Time Until:   23.59 
Use Shift:   Late 

 
 
In this example we can see that an employee who clocks in at 08.00 on Monday will be placed in 
the Early shift and will use Day Rule One. If on Tuesday, he clocks in at 14.00 he will be placed on 
the Late shift and will use Day Rule Two. 
 
To Create a Shift Group click the ‘New’ button on the lower toolbar and enter a meaningful 
description such as ‘Early and Late’. 
 
Use the ‘Add Shift’ button to add as many shifts as required (the new shift will be ‘Default’, click on 
the dropdown box and select the desired shift.) 
 
The shifts should be in the order that an employee could use them, for example Early, Late, and 
Night etc. if a night shift is involved it should always be the last shift. 
 
Against each shift, enter the ‘Until’ time. TimePro will look at the first IN clocking and decide which 
shift the employee is using based on the ‘Until’ time. (see the example above) 
 
To Delete a Shift Group, click the ‘Delete’ button on the lower toolbar. TimePro will not allow you to 
delete a Shift Group that is in use. 
 

Shift Organiser 
The combination of Day Rules, Shifts and Shift Groups can become quite complex. To see the 
combination in a graphical layout, click the  button on the top toolbar. 
This screen is for information only and shows how the Shift Groups, Shifts and Day Rules fit 
together. Click the + signs to expand the views and the – sign to collapse the views. 
 

Job Costing Setup 
The Job Costing Setup is accessed by clicking the  button on the top toolbar. 
 
The screen has three tabs: 

Sale Codes 
These are the codes that the employees use when they clock onto a job. Number 5 is always Non-
Productive and should have a value of £00.00. 
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To Add a new code, click the ‘New’ button on the lower toolbar. Enter the number (between 10 and 
60), a description and a value for the code. The value should be the average rate per hour that this 
work is sold for. 
 
The descriptions and values can be edited directly in the grid at any time. 
 
If you create a new code, it can be used at the clock(s) straight away. However, the clock will 
report the code as ‘Not Used’ on the display and the labels. You will require the clock EPROM 
reprogramming to show the new code(s). Please contact MIM Systems who will carry out this work 
at a minimal charge. 

Sale Code Alias 
This field is for use with the DMS Import (See Import Setup on page 17) the identifier that the DMS 
system uses for each sale code should be entered here. 
 
To Delete a code, click in the grid on the code you wish to delete and click the ‘Delete’ button on 
the lower toolbar. TimePro will not allow you to delete a code that is in use. 

Non-Productive Codes 
These are the codes that are used on the downtime cards. An employee at the clock uses these 
cards when he does not have a job to clock onto. There are two types of Non-Productive work: 

1. Allowed 
These are activities where an employee could not physically work on a productive job. For 
example, driving, on-site training etc. you should use the number range 2000 to 2040 for 
these codes. 
 

2. Disallowed 
These are activities where an employee would be available to work on a productive job. For 
example, waiting or idle time. You should use the number range 2041 to 2050 for these 
codes. 

 
Whether a code is allowed or disallowed is used in the ‘Performance Report’. On all other reports 
Non-Productive time is shown as zero time sold. 
 
To Add a new Non-Productive code, click the ‘New’ button on the lower toolbar. Choose Allowed 
or Disallowed and enter a description. TimePro will allocate a code for the new activity that you 
should use to punch out a new card. 
 
Badge Labels can be printed by clicking the ‘Badge’ button on the lower toolbar. 
 
To Delete a code, click in the grid on the code you wish to delete and click the ‘Delete’ button on 
the lower toolbar. TimePro will not allow you to delete a code that is in use. 
 

Options 
The following options can be set for Job Costing: 

 
1. Days to look back for last job. 

If you set an employees ‘Default Job’ to ‘Last known clocking’ this is the days that TimePro 
will look back. If no job is found TimePro will clock the employee onto ‘Missed Clocking’. 
(See ‘Default Job’ under ‘Employee Tab’ on page 21) 
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2. Minutes before AutoClock invoked 
(See ‘Default Job’ under ‘Employee Tab’ on page 21) 
 

3. Job Number size 
Choose either six or eight depending on the configuration of the TimePro clocks. (NOTE 
this setting will not alter the ability of the TimePro clocks to accept either 6 or 8 digits. 
Please contact MIM Systems for an EPROM upgrade if you require 7 or 8 digit job 
numbers) 
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TimePro DMS Import file specification 
 
The file should be a CSV format file with the following information: 
  
1.    Job Number (Max 8 digits) 
2.    Total of Hours Sold (Allowed) by Sale Type (IE Retail, Warranty, Internal) 
3.    Sale Type (Max 30 Characters) 
   
The columns can be in any order 
  
The Sale type must identify the type of work sold (usually Retail, Warranty or Internal) It can be a 
letter, number or word. 
  
If a Job Number has hours sold against more than one sale type, for example Retail and warranty, 
then that Job number should have two rows one for retail and one for warranty. 
  
The Hours sold should be Totals, not separate labour lines. 
  
Only Costed (Invoiced) Job numbers to be included 
  
No credit notes to be included 
  
Only Job numbers involving labour to be included. 
  
Only worked labour to be included (no sublet) 
  
  
SAMPLE FILE OUTPUT: 
  
111111,    R, 1.2 
111111,    W, 2.2 
222222,    I , 3.5 
333333,   R,2.2 
  
Job number, hours and sale type are mandatory fields. The following additional fields can be 
included in the file if required: 
 

1. Company Number  (Integer) 
2. Invoice Number (Text, Max 10 Characters) 
3. Customer (Text, 29 Max Characters) 
4. Reference (Text, Max 100 Characters) 
5. Comment (Text, Max 255 Characters) 
6. Invoice date (Text, format ddmmyy OR dd/mm/yy) 

 
Ideally, the user should be able to produce the file by specifying a date range. If the file is produced 
automatically (at end of day routine for example) then either a backup copy of the file should be 
made or the user given the ability to produce the file at will. 
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Setting the TimePro Clock Terminal for British Summertime 
 
The TimePro terminal can be programmed to change in March and October for the start and end of 
British summertime. When the TimePro system is installed, the clocks are programmed for the next 
two changes.  
 
You will need the ‘Mode 2’ card that was supplied with the TimePro system. 
 
1) Before making any adjustment to the clock, you need to ensure it is set to BST (British 

summertime) or GMT (Greenwich Mean Time) as appropriate.  
A) If the current date is after the October time change and before the March time change the 

clock display should show the letter ‘G’ in the top right hand corner of the display.  
B) If the current date is after the March time change and before the October time change the 

clock display should show the letter ‘B’ in the top right hand corner of the display. 
C) If the display is showing a ‘G’ when it should be a ‘B’ or vise versa then the clock is out of 

step with the changes and should be changed as follows, (if it is showing the correct setting 
then go to 2) 

(a) Insert and remove the Mode 2 card, the display will now read ‘Mode 2 Selected’ 
(b) Press the ‘Enter’ Key THREE times, the display will now read ‘Mode 5 Selected’ 
(c) Press button 9 ONCE, the display will read ‘Change now’ and either ‘Spring 

Change ‘ or ‘Autumn Change’ you can scroll between the two by pressing 
buttons 5 & 6 respectively. Choose whether you want to change to BST (Spring 
Change) or GMT (Autumn Change) and press ‘Enter’ 

(d) When you have made the change, press ‘Clear’ twice to return to the normal 
display. 

(e) IF YOU HAVE HAD TO MAKE A CHANGE AS ABOVE then you will need to 
set the clock time using TimePro software (See Setting Clock Time on 
Page 25) 

 
2) To set the next two Dates for the time changes, carry out the following: 

A) Insert and remove the ‘Mode 2’ card the display will now read ‘Mode 2 Selected’ 
B) Press ‘Enter 3 times, the display will now read ‘Mode 5 Selected’ 
C) Press button 8 once 
D) The display will read ‘Change on date Spring Change’ 
E) Press enter once, the display will read ‘Spring Change Date- nn – Mar. 
F) Use buttons 5 & 6 to scroll the date to the required setting (Usually the last Sunday in 

March) 
G) Press Enter to confirm the date 
H) Press button 6, The display will read ‘Change on date Autumn Change’ 
I) Repeat steps E to G (Usually the last Sunday in October) 
J) When all changes have been made, press ‘Clear’ twice to return to the normal display. 

   


